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1 Introduction

The Long-Distance Sensor Bus (LDSBus) Configuration Utility (V.1.2.2) enables
configuration of an LDSBus to be connected to an LDSBus host system.

The tool has two main menu functions:

e LDSU (LDS Unit) Project
e LDSBus Project

1.1 LDSU (LDS Unit) Project

An LDSU Project can be created to configure LDSBus Devices (Sensors/Actuators) before
they are connected to the LDSBus. Only one LDSBus Device can be configured at a time.
The configuration page provides information about LDSBus Devices and their sensors as
well.

1.2 LDSBus Project

The LDSBus Project is capable of simulating an LDSBus host system environment in which
it identifies how many LDSBus devices are online. Additionally, the tool provides an
estimate of the total power consumed over the LDSBus, which is useful when considering
the power limitations of the LDSBus Host to which the LDSBus is attached. It is possible
to view the detailed information about any LDSBus device on the bus.

LDSBus also has other features, such as the ability to read and write registers in LDSBus
Devices, as well as the ability to update firmware.
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2 Hardware Setup Pre-requisites

The following components are required to create a LDSU or LDSBus Project:

Windows based PC
USB Type A to Type C Cable
LDSBus USB Adapter

LDSBus Device(s) using RJ12/11 cable(s) to RJ12/11 cable(s) or RJ12/11 cable(s) to JST
4/6 cable(s)

For LDSBus Project Only:
e LDSBus HVT Junction (s)

e CAT 5e RJ45 to RJ45 Cable (s)
e 24VDC/18W Power Adapter

2.1 LDSU (LDSUnit) Project

TYPE -C

wsa - LDSBus USB Adapter 9
15T 4/6 pin

TYPE -A o i /‘} af :
[ ] RI1Z/RIL1 'y RI12/RI11 _ Device
o/

LD5Bus

Figure 1 — LDSU Device (Sensors / Actuators) Connection Diagram

Step 1: Connect the LDSBus USB Adapter to the Windows PC using the USB-C to USB-A cable.
(Or a USB-C to USB-C cable, if the PC has Type-C USB Ports)

Step 2: Connect the LDSBus Device to the cable at one end.

Step 3: Connect the other end of the cable to the LDSBus USB Adapter as shown in Figure 1.

Step 4: For instructions on configuring the LDSBus device, refer to the Software section.
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2.2 LDSBus Project

RiS{CAT ]

e——y = L L
_ RARIAL R
R CAT S ? ? ? ?
o © - -

LRI T BT 4f&pin LU ] IAF 46 pin

Figure 2 — LDS Bus — HVT Junction in LDSBus System - Connection Diagram

Step 1: Connect the LDSBus USB Adaptor to the Windows PC using the USB-C to USB-A cable
(or a USB-C to USB-C cable if the PC has Type-C USB Ports).

Step 2: Connect a 24VDC/18W power adapter to the DC jack and turn it ON. The LDSBus and
devices will be powered by software.

Step 3: Using an RJ45 (CAT5e) cable, connect the first HVT-Junction to the USB Adapter.
LDSBus devices connected to the LDSBus HVT-Junction must be preconfigured through
LDSU Project.

Step 4: In case of more than one LDSBus HVT-Junction, chain the connections together using
RJ45 (CAT5e) cables. Ensure that termination is enabled for the last LDSBus device in
the bus through the LDSU Project.

Step 5: For details on how to access the bus, see the Software section.
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3 Installing LDSBus Configuration Utility
3.1 First Time Installation
Following are the steps to install LDSBus Configuration Utility for the first time -

1. Run the Setup.exe file provided with the installation package.

&

LDSBusConfigura
tionUtility_Setup_
v1.1.0.0

2. A Welcome message appears along with LDSBus Configuration Utility Installer Wizard.
Click [Next].

0 LDSBus Configuration Utility == *

(@] Welcome to LDSBus Configuration
Utility Installer
Setup will guide you through the installation of LDSBus
Configuration Utility.
It is recommended that you dose all other applications

before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

l Click Mext to continue,

%

=
o0
wn
(&)
-

==

Figure 3 — Setup Wizard — Welcome Screen

3. A License Agreement is displayed. Click [I Agree] to proceed.

0 LDSBus Configuration Utility - b4

License Agreement
Please review the license terms before installing LDSBus

Configuration Utility.

Press Page Down to see the rest of the agreement.

iThese license terms constitute a contract between you and BRT SYSTEMS PTELTD. ~
Flease read the license terms through carefully, They apply to all software and the

related products from BRT SYSTEMS PTE LTD and, if applicable, to the media on which

you received these. These terms also apply to all updates or bug fixes as well as to all

user manuals, programming instructions and other documentation, supplements and
support services offered by BRT SYSTEMS FTE LTD. If any other terms are induded with
the fore-mentioned products, they shall be applicable,

1. License Terms
By agreeing to these license terms, you acknowledge their validity fully and without Y]

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install LDSBus Configuration Utility.

Figure 4 — Setup Wizard - License Agreement
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NOTE: At any point of time, during the installation, users may click [Back] to navigate to the previous
window or click [Cancel] to abort the installation process.

4. Select or edit the Start Menu Folder Name. Click [Next].

# LD5Bus Configuration Utility = x
‘ Choose Start Menu Folder
Choose a Start Menu folder for the LDSBus Configuration Utility
@ shortcuts,

Select the Start Menu folder in which you would like to create the program's shortouts. You
can also enter 3 name to create a new folder,

f.0SEus Configuration Utiity]

7-Zip -
Accessibility

Accessories

Administrative Tools

Amazon

Atlassian

Bandicam

Bridgetek

| CMake

Device Monitoring Studio

Edipse

Electronic Team W

Figure 5 — Setup Wizard - Start Menu Folder Selection

5. Select a "Destination Folder” for installing the files. Accept the default folder or
click [Browse] to specify a different location. Click [Install] to start the installation.

ﬁ LDSBus Configuration Utility o =
‘ Choose Install Location
@ Choose the folder in which to install LDSBus Configuration Utility,

Setup will install LDSBus Configuration Utility in the following folder, Toinstall in a different
folder, dick Browse and select another folder, Click Install to start the installation.

Destination Folder

‘:\Program Files {x86)\BRTSystems\LDSBus Configuration Utility] | Browse...

Space required: 6.8 MB
Space available: 11.4 GB

< Back Install Cancel

Figure 6 — Setup Wizard - Installation Location Selection
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6. A progress bar indicates that the installation is in progress.

O LDSBus Configuration Utility =

N3 Installing
L Please wait while LDSBus Configuration Utllity is being installed,

)

Extract: ScottPlot.dll... 100%

Qutput folder: C:'\Program Files {x86)\BRTSystems\LDSBUs Configuration Utility
Extract: License.txt... 100%

Extract: LDSBusConfigurationUtlity.exe... 100%

Extract: FTD2}X_NET.dIl... 100%

Extract: Newtonsoft.Json.dll... 100%

Extract: LDSBuslb.dll... 100%

Extract: System.ValueTuple.dll... 100%

Extract: System.Drawing. Comman.dll... 100%

Extract: ScottPlot.dll... 100%

%)
i
i

o
1]

Figure 7 — Setup Wizard - Installation Progress

7. Upon successful installation, click [Finish] to close the setup. Select the check box to
run the utility (optional).

0 LDSBus Configuration Utility =

O Installed Successfully
LDSBus Configuration Utility has been installed on your
computer,
Click Finish to dose Setup.

Run LDSBus Configuration Utility

7p)

-
N
(&
-

Figure 8 — Setup Wizard - Installation Complete
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8. By default, the LDSBus Configuration Utility is installed in this path - "\Program Files
(x86)\BRTSystems\LDSBus Configuration Utility.”

7 = | BRTSystems = (m] X

Home Share View o

“ v < Program Files (x86) > BRTSystems * v

Search BRTSystermns

o

o] Mame Date modified Type Size

# Quick access
LDSBus Configuration Utility 13/10/2022 1:23 PM File folder
@ OneDrive - Personal
v [ This PC
B 3D Objects
I Desktop
%| Documents

‘i- Downloads

Figure 9 — LDSBus Configuration Utility Installation Folder location

9. The LDSBus Projects folder is the default folder that contains the projects saved by the
utility.

] = | BRTSystems = =] *
m Home Share View 0
“ + » ThisPC » Documents » BRTSystems » ~ | O Search BRTSystem

o Mame ! Date modified
# Quickaccess
LOSBus Projects

| Documents of

| LDSBus_Python SDK S
& Downloads LDSBusPythonSDK_v2,0.0
= Pictures ¥ LDSU Projects e

Figure 10 — LDSBus Projects Folder Location
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3.2 Update to a new version

NOTE: While updating to a new version, an uninstaller will run and this will remove the previous
package and information from the registry information. First time installation will not show the
uninstaller.

Following are the steps to update to a latest version of LDSBus Configuration Utility —

1. Run the Setup.exe file.

2. The LDSBus Configuration Utility Uninstaller is displayed. Click [Next].

O LDSBus Configuration Utility — X

(@] Welcome to LDSBus Configuration
Utility Uninstaller
Setup will guide you through the uninstallation of LDSBus
Configuration Utility.
Before starting the uninstallation, make sure LDSBUs

Configuration Utility is not running.
Click Mext to continue.

2.
-
an
72
o
-

Figure 11 — LDSBus Configuration Utility - Uninstaller

3. Click [Uninstall] to start uninistalling the old version. The uninstallation will be in

progress.
ﬁ LD5Bus Configuration Utility Uninstall — X
Uninstall LD5Bus Configuration Lkility
Remove LD5Bus Configuration Utility from your computer.

LDSBus Configuration Utility will be uninstalled from the following folder. Click Uninstall to start
the uninstallation.

Uninstalling from: | C:\Program Files (x86)\BRTSystems\LDSBus Configuration Utility, |

< Back Uninstall Cancel

Figure 12 — LDSBus Configuration Utility — Uninstallation in Progress
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4. Click [Finish] to complete the uninstallation.

O LDSBus Configuration Utility e

(o) Uninstalled Successfully
LDSBus Configuration Utility has been uninstalled from your
computer,
Click Finish to dose Setup.

:

%

-
0
(%2
o
=l

< Back Cancel

Figure 13 — LDSBus Configuration Utility — Uninstallation Completed
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4 LDSBus Configuration Utility — GUI Overview

LDSBus Configuration Utility

File Settings About

Figure 14 — LDSBus Configuration Utility User Interface

4.1 Default Menu bar

By default, the menu bar contains File, Settings and About menu options.
File Settings About
4.1.1 File Menu

In the menu bar, the first item is the File menu. It contains commands that are used to
manage Projects, such as New Project, Open Project, and Save Project etc.

File Settings About

New Project »
Open Project
Save

Save As

Close
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Menu Item

Description

New Project

To create a new LDSU / LDSBus projects

Open Project

To open or retrieve an existing LDSU / LDSBus project.

Save To save the project. The file is saved with an “.Idsuproj” extension for
LDSU projects and an “.ldsbusproj” extension for LDSBus projects.

Save As To choose a different destination and file name to save the current
project. The file is saved with the extension ".ese".

Close To close the utility

4.1.2 Settings Menu / Interface

From the menu, click the Settings option to access the Settings interface. The settings

screen lists the available LDSBus USB Adapter’s serial number. Click Refresh icon

get the new devices (if any).

Settings

LDSBus USB Adapter

DTSNLBWA

W

. Cancel

Figure 15 - Settings Interface

1. Select the required adapter from the dropdown list.
2. Upon selecting the adapter, click [Select] to use the adapter. Alternately, click
[Cancel] to return to the previous screen.

4.1.3 Additional Menu (based on the selected Project)

LDSU Project

File LDSU Commands Firmware Update

to

Settings About

LDSBus Project

File LDSBus

Commands Settings

About

Product Page
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5 LDSU (LDSUnit) Project
5.1 Creating a New LDSU Project

To create an LDSU Project -

1. Choose the LDSBus USB Adapter from the Settings menu. Refer to Section 4.1.2.

LDSBus Configuration Utility

Settings

Settings

LDSBus USB_Adapter
DTSNLBWA

Cancel

Figure 16 — LDSBus USB Adapter Selection

2. To create an LDSU project, click File > New Project > LDSU Project.

LDSBus Configuration Utility

File Settings  About

New Project LDSU Project

Open Project LDSBus Project

Save

Figure 17 - Project Type Selection Menu
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3. Based on the selected project, the application title will be displayed. For example, if
the selected project type is "LDSU Project,” then the title displayed will be "LDSBus
Configuration Utility — LDSU Project.” Enable the LDSU port power on the LDSBus
Device connected to the LDSBus USB Adapter. Click [Scan].

LDSBus Configuration Utility-1DSU Project

File LDSU Commands Firmware Update Settings About

r LDSU Port Power

R ‘

Figure 18 — LDSU Project Interface

4. Upon finding a device, the information related to the connected LDSBus Device will be
displayed. The details of the sensor device are displayed at the bottom of the interface.
Except for LDSU ID; LDSU Termination Status and Nickname all the other fields are
non-editable.

LDSBus Configuration Utility-LDSU Project

File LDsSU Commands Firmware Update Settings About

Enable

LDSU ID

Serial Number
LDSU Termination

Frroduce Nae N Litake LDSBus Thermocouple Sensor
LDSU Class

Manufacture Date ST

Calibrated Current (mA) &

Calibrated Voltage (mV) i

Calibrated Temperature (°C) 25

Calihrated Date Not Applicable

Number of I2C Devices 2

Software Version =

I2C Devices

Manufacturer : Bridgetek Pte Ltd. Manufacturer : MICROCHIP
PartNumber < PartNumber : MCP9600
Address Address

Capability Capability

: 1008 ms Report Rate : 1000 m|
Class ID : @x0100 Class ID : @x@100

Figure 19 — LDSU Project Interface
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5. Configure the following LDSU Device settings, if required:

LDSU 1D
LDSU Termination 5 ‘

Nickname LDSBus 4inl Sensor

Update

Figure 20 — LDSU Device Settings

LDSU ID: Default is set as '126". Change the ID accordingly based on the number of
devices that will be connected to the LDSBus. For example, if you will be connecting
more than one LDSBus Device on the bus, configure the first device with an ID of ‘1,
second device with an ID of ‘2" and so on. Each LDSBus Device must have a unique ID.

LDSU Termination: Default is set as ‘Off. Ensure termination for the last LDSBus
Device on the bus is set as ‘On.’

Nick Name: Default is set as the product name. Change the device name accordingly.
The device name set will be reflected in the LDSBus Host System.

Click [Update] to save any changes.

Click [Calibrate] to start the calibration. Refer to Section 7 for more information on
the Calibration procedure.

18

Product Page
Document Feedback Copyright © BRT Systems Pte Ltd



BRTSYS_AN_001 LDSBus Configuration Utility Guide

-a BRTSYS Version 1.4

Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

5.2 Firmware Update
This function allows users to update the device firmware. To update firmware,

1. Select Firmware Update from the menu. A file browser dialogue box is displayed.
Browse for the device update package (.unv) and click [Open].

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU Port Power

Status On

[1))1 [ ) 5 ovse unv Files
uuID L

Look y: | || L50301 V\ Q7 m

Serial Number Hi2aEy *+ Name Date modified

sl 1 LDSU_Thermocoupleuny 19/9/2022 5:55 PM
Product Name Bk Cuick access

Bus Thermocouple Sensor
LDSU Class exseo |

— Desktop
Manufacture Date B

Galibpated Guprent (mh) Uh':m
Calibrated Voltage (mV)
Calibrated Temperature (°C)

Calibrated Date

S File pame: I
Network
Number of I2C Devices Files of type:

unv files (*unv)

[ Open as ead-only
Software Version

I2C Devices

Manufactur Bridgetek Pte Ltd. Manufacturer : MICROCHIP
RT-VDEV PartNumber : MCP9600
Address 2]
Capability :
Report Rate : 1808 ms Report Rate : 1008 ms
Class ID : @x0180 Class ID : @x8100

Figure 21 - Firmware Update / File Browser Interface

2. Upon selecting a valid firmware package, a confirmation window is displayed. Click
[OK] to proceed with the firmware update. Alternately, click [Abort] to cancel.

LDSBus Configuration Utility-1DSU Project

File LDSU Commands Firmware Update Settings About
LDSU Port Power
Sretuss o "

18
Serial Number 3AZ4E659

Off
Headuct Nowa LDSBus Thermocouple S

Lbsbus lhermocouple Sensor
LDSU Class

Manufacture Date 2
Calibrated Current (mA) 63
Calibrated Voltage (mV) 5040

5 Confirm Fir
Calibrated Temperature (°C) 25

i ;

Calibrated Date ot Senlict
Number of I2C Devices e

Software Version HS

I2C Devices

Manufactur Bridgetek Pte - Manufacturer : MICROCHIP
RT-VDEV r MCP9680

Capability :
Report Rate 1000 ms
Class ID : @x@lee

Figure 22 - Firmware Update Confirmation Window
OR
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If the device is already updated with the latest firmware, an appropriate warning message
is displayed. Click [Yes] to overwrite the existing version or [No] to cancel the firmware

update.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

Firmware Update i About

LDSU Port Power
Status: o 7

Serial Number

Product Name

LDSU Class

Manufacture Date
Calibrated Current (mA)

Calibrated Voltage (mV)

LSt 10103152
3A24E659

LDSBus Thermocouple Sensor

Device already updated with latest firmware.
Continue to Overwrite

Calibrated Temperature (°C)

Calibrated Date
Number of T2C Devices

Software Version

I2C Devices

Manufacturer :
PartNumber : BRT-VDEV
Addre exen
Capability (2}

Report Rate 1600 ms
Class ID : 9x0100

Bridgetek Pte Ltd.

Manufactur MICROCHIP
PartNumber 1CP9608
Address ]
Capability ]

Report Rate 1000 ms
Class ID : (=1}

Figure 23 - Firmware Overwrite Alert Window

LDSBus Thermocouple Sensor

3. A dialog window with the information about the current firmware version and the
new firmware version that will be installed, is displayed. Click [OK] to proceed.

LDSBus Configuration Utility-1LDSU Project

File LDsU Commands

Firmeare Update Settings  About

LDSU Port Power
phi o "

LDSU
uuID

Serial Number

Product Name

LDSU Class

Manufacture Date
Calibrated Current (mA)

Calibrated Voltage (mV)

Calibrated Temperature (°C)

Calibrated Date
Number of I2C Devices

Software Version

I2C Devices

Manufacturer :
PartNumber
Address
Capability
Report Rate : 1608 ms
Class ID : @x0100

BRT-VDEV

Bridgetek Pte Ltd.

3A24E659

LDSBus Thermocouple Sensor
08001

2021-Aug

63

5040
Current Vi

Update to Ve
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PartNumber
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Report Rate : 1608 ms
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Figure 24 - Firmware Version Information
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4. An appropriate message indicating that the firmware update is successful or not is
displayed. Click [OK] to close the window.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands. Firmware Update Settings About

LDSU Port Power
e -

LDSU
uuID gaial

Serial Number ehriac]

Broduce Nane LDSBus Thermocouple Sensor

LDSU Class 0x8801

Manufacture Date e

Calibrated Current (mA) 63

Calibrated Voltage (mV) se4e

25

|
! Firmuare Update Successful
Calibrated Temperature (°C) !

Ealibeated Date Not App|
1

Number of I2C Devices e |

Software Version

I2C Devices

Manufactui ridgetek Pte Ltd. Manufact! : MICROCHIP
RT-VDEV r MCP960@

Capa y Capa £
Report Rate : 1000 ms Report Rate : 1000 ms
Class ID : @x0100 Class ID : ©x8100

Figure 25 - Firmware Update Successful Message Window

Firmware Update Unsuccessful

Figure 26 — Firmware Update Unsuccessful Message Window

Invalid binary file

Figure 27 - Firmware Update Error Message Window
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5.3 LDSU Command Interface

The LDSU command interface is used to communicate with the LDSU module by selecting
the command from the list of support commands. The command settings are available
only if the device is found on the bus. To access the Commands window,

1. Select Commands from the menu.

LDSBus Configuration Utility-LDSU Project

irmware Update Settings  About

LDSU ID 126 (Ox7E)

Commands Response

<Command without response>

Command

LDS Message Logger - 13:54:48.46808636

Figure 28 — LDSU Project - Commands Interface

2. The Commands interface is displayed.

LDSU ID - Displays the selected Device ID

Command - Displays a list of LDS Commands in a drop-down box

Response — Upon selecting a command and clicking [Send], the device response
will extract the packets and display them in the response box. Refer to Table 1 for
the list of commands with response and without response. Refer to Figure 30 for a
sample command with response. Refer to Figure 31 for a sample command without
response.

LDS Message Logger — Displays the query and response logger.

Figure 29 — LDSU Project - Commands List
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Refer to Table 1 for the list of commands.

Commands with payload and response READN; WRITEN; READ; ECHO
Commands without payload and no response RESET; IDENTIFY;I2CREGOFF
(Same UI)

Commands with payload and no response I2CREGON; SETI2CSPEED; WRITE
Commands without payload and with response INFO; STATUS; GETUUID

Table 1- List of Commands

LDSBus Configuration Utility-LDSU Project

File LDsSU Commands Firmware Update Settings About

Target LDSU

LDSU ID 126 (x7E)

Commands

Command ‘ 2-07-00

LDS Message :54:48.4680636

LDSBus Configuration Utility-LDSU Project

File Losu Commands Firmware Update Settings About

Target LDSU

LDSU ID 126 (@x7E)

Commands -
<Command without response>

Command

LDS Message Logger - 13:54:48.4680636

Figure 31 — Sample Command without Response
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5.4 Saving LDSU (LDSUnit) Project

Upon creating an LDSU Project, users may save the project. To save a project —

1. Click File > Save.

LDSBus Configuration Ut y-LDSU Project

LDSU Commands. Firmeare Update Settings About

New Project »
rer

Open Project Enable

LDSU ID 126 v
LDSU Termination off -

Nickname LDSBus €02 Sensor

Update

proauct name

LDSU Class ox8011
Manufacture Date 2022-Oct
Calibrated Current (mA)

Calibrated Volta

Calibrated Temperature (°C) [2°
Calibrated Date 2022-0ct-12
Number of I2C D

Software Version
I2C Devices

Manufacturer : BRT Systems Pte Ltd. Manufacturer : ROHM Semiconductor Manufacturer : Sensirion Manufacturer : Sensirion
PartNumber : BRT-VDEV PartNumber : BH1730FVC PartNumber PartNumber : SCD4@
Address : 800 Address 5 Address : @ Address : @

Capability : @ Capability : @ Capability : Capability

Report Rate : 1800 ms Report Rate : 1800 ms Report Rate Report Rate

Class ID : 6x0384 ™ 401 Class 1D Class ID

Figure 32 - Save LDSU Project

2. By default, the project will be saved under this Ilocation - /My
Documents/BRTSystems/LDSBus Projects. However, users may select a preferred

to location to save the project. The LDSU project will be saved with a file extension
- .Idsuproj.

LDSBus Configuration Utility-LDSU Project

File | LDSU Commands Firmware Update Settings About

LDSU Port Pows
at On Enabl

& 3 Save LDSU Project Files
~ial Number £y < BRTSys... » LDSBus Projects kearch LDSBus
Product Name Organize v New folder

~ €02 Sensor
DSU Class [0 This pC Name Datemodified
- L

1 30 Objects [] €o28ensorldsuproj 111072
B Desktop
Calibrated Current (mA) %] Documents
& Downloads
D Music
Calibrated Temperature (°C) 2 =] Pictures
B Videos

Manufacture Date

Calibrated Voltage (mV)

Calibrated Date

File name: ||

Number of I2C Devices

Saveas type: | LDSU Project files (*Idsuproj)
Software Version

L2t beva ~ Hide Folders
Manufacturer : BRT Systems Pte Lta-  mManuts UMM SemLCoNauCtor manutactur : Manufacturer : Sensirion
BRT-VDEV PartNumber : BH173@FVC PartNumber PartNumber : SCD4®
Addr 29 Addr Addr 0x62
Capability Capability : @ Capability Capability
Report Rate : 1000 ms Report Rate : 1008 ms Report Rate Report Rate
Class ID : 0x@304 Class ID : 0x8401 Class ID : 0 Class ID

Figure 33 - Default Location to Save LDSU Project
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3. Figure 34 shows a sample LDSU Project saved under the default location.

'™ + | LDSBus Projects
Home Share View
<« v < BRTSy.. » LDSBus Projects v | D
A Name

3 Quick access
|| CO2%ensorldsupraj

@ OneDrive - Personal
|:| Thiz PC

J 3D Objects

[ Desktop

.j Documents

‘ Downloads

J" Music

&=/ Pictures

m Videos

. Windows (C:)

s Recovery Image (D)

1item

Search LDSBus Projects

Date modified

= O >

Type Size

LOSUPROY File KB

>

Figure 34 — Sample LDSU Project Saved under default location

File > Save As.

NOTE: A copy of the file can be made in a different folder or with a different name by clicking the

5.5 Opening a LDSU Project
To open an existing LDSU Project,

1. Click File > Open Project.

LDSBus Configuration Utility-LDSU Project

LDSU Commands Firmware Update Settings About

New Project »

Open Project

Save

Enable

Save As

LDsU ID

"
Close

LDSU Termination

PHAte e Nime LDSBus €02 Sensor

Mickname

LDSU Class ox8611

Manufacture Date 2022-0ct-03
Calibrated Current (mA) 28
Calibrated Voltage (mV)

Calibrated Temperature (°C) |25
Calibrated Date A Ueedl

Number of I2C Devices 2

Software Version 2.

I2C Devices

Manufacturer : BRT Systems Pte Manufacturer :
PartNumbe RT-VDEV PartNumbei
Addre Address
Capability : @ Capability
Report Rate 1008 ms Report Rat 1800 ms
Class ID 4 c1 D : xe401

H1730FVC

ROHM Semiconductor

Manufacturer :

Report Rate
Class ID :

Sensirion
PartNumber : SCD40

Addr 8x62
Capability : 1

LDSBus €02 Sensor

Manufacturer :
PartNumb,

Sensirion

Class ID :

Figure 35 - File - Open Project Menu
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2.

Browse for the project in the File browser and select the LDSU Project. By default,

the Files of type filter box display LDSBus Projects (*.ldsbusproj). Click the box and

select a LDSU Project.

Click and open the LDSU Project.

LDSBus Configuration Utility-LDSU Project

File LDsU Commands

LDSU Port Power

Stats On

Firmware Update

Settings

® Enable

B Browse LDS Project

uuID
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Product Name
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Software Ver

I2C Devices
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Capability : @

Report Rate
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Y e@irm
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resources

*

Quick access
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Desktop
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<

File name

Files of type:
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13/10/2022 1:46 PM
13/10/2022 1:46 PM
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Capability : @
Report Rate :

Class ID :

1000 mp
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Report Rate
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File fo
File fo
File fi
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[ AR [o= s

LDSBus Projects(*idsbuspro}’)

Cancel

Sensirion

SCD48

ox62

al,
5000 ms
304

LDSBus CO2 Sensor

Manufactur : Sensirion
PartNumber SCD48
Address : 0x62
Capability : 1

Report Rate
Class ID :

5000 ms
8x8160

Browse LDS Project % O Browse LDS Project e
Look in \ Projects < @ m- Lock in: | LDSBus Projects v| e mE
; Name - Date madified W * Name Date modified Tpe
ﬁ' No items match your search, _| CO2Senser.ldsuproj 11/10/2022 9:34 AM LDSU
Quick access Quick access
[
Desktop Desktop
" -
Libraries Libraries
This PC This PC
< > < >
é Fle ame: [ ~] [ s File name: [ v [een
Network Metwark
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Figure 36 - File Browser — LDSU Project Selection
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3. The LDSU project is opened in the project window.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands. Firmware Update Settings About

LDSU Port Power

uuTD

LDsU ID
Serial Number

LDSU Termination
Product Name LDSBus CO2 Sens:

Nickname
LDSU Class 0x8011

Manufacture Date peE
Calibrated Current (mA) i

Calibrated Voltage (mV)

Calibrated Temperature (°C) 25

Calibrated Date Hot faplca e
Number of I2C Devices

Software Version

I2C Devices

Manufacturer : BRT Systems Pte Ltd. Manufacturer : ROHM Semiconductor Manufactur Sensirion Manufacturer : Sensirion
PartNumber : BRT-VDEV PartNumber : BH173@FVC PartNumber : SCD48 : SCD40
Address : ©x80 Address 2 Addre. 62
Capability : @ Capability Capability : 1 Capability :

Report Rate 1008 ms Report Rate 1000 ms Report Rate 50080 ms Report Rate 5000 ms
Class ID : @304 Class ID : 0401 Class ID : @ e Class ID 1100

Figure 37 — LDSU Project Window

Refer to Section 5.1 for more information on creating the LDSU project.
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6 Creating a New LDSBus Project
To create an LDSBus Project -

1. Click File > New Project > LDSBus Project.

LDSBus Configuration Utility

Figure 38 - Project Type Selection Menu

2. Based on the selected project, the application title will be displayed. For example, if the selected
project type is "LDSBus Project,” then the title displayed will be "LDSBus Configuration Utility -
LDSBus Project.” Enable the LDSU port power on the LDSBus Device connected to the LDSBus
USB Adapter. Click [Scan] to scan the devices in the bus.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

& Enable ‘ ‘
Figure 39 — LDSBus Project Interface

3. Upon finding the device(s), information related to LDSBus Device will be displayed.
There are two view options available, namely LDSU IDs View and LDSU List View. By
default, LDUS IDs view is displayed.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

LDSBus Power

Status: On

LDSU IDs LDSU List

Total Online LDSUs: |3 Estimated Power Consumption (mW) :
New Online LDSUs: 3

Filter: [A388

13 || 97

Figure 40 - LDSBus Project Interface (LDSU IDs View)
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4. The following details are displayed as part of the LDSU IDs view -

e Total number online LDSU devices: Displays the total humber of LDSBus Devices
which are physically connected and detected on the bus.

e New online LDSU devices: Displays the total number of new LDSBus Devices which
are physically connected and detected on the bus.

e Estimated Port Power Consumption: Displays the estimated total power consumed
by the bus

e Online/Offline Device Filter: To filter all, online, offline, or new online LDSBus
Devices. LDSBus Devices ID displayed based on filtering results.

LDSU IDs LDSU List

Total Online LDSUs: Ej Estimated Power Consumption (mW) : 16082
New Online LDSUs: 3

Filter: All

13 a7

5. Switch to LDSU List to view the basic device information. The list view displays all the
LDSBus Devices connected in the bus with some device information. The LDSU List
view displays the following information - Device UUID; Device’s Nickname,; Date on
which the device was last calibrated; Termination Status (ON / OFF).

Click Details to view the detailed information about the device.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

LDSBus Power

Status: On Enable

LDSU IDs LDSU List

in uuIip Nickname Last Calibrated Termination Details

2822-Jun-8

Figure 41 — LDSU List Interface
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6. Upon clicking the Details link, the detailed LDSU information is displayed.

LDSU Information

uuID

Serial Number
Product Name
LDSU Class

LDSU Termination
Nickname

Calibrated Current (mA)

Calibrated Voltage (mV)

Calibrated Temperature (°C)

Number of I2C Devices

LS1181XXXXXXXX22616

466

LDSBus CO2 Sensor

ox8011

off

LDSBus CO2 Sensor

58

Figure 42 — LDSU Information

LDSU Information

rial Number
oduct Name
LDSU C1
LDSU Term
Nickname
Calibrated Current (mA)

Calibrated Voltage (mV)

Number of I2C Devices

Click [Commands] to access the command interface.

Click [Delete] to remove any of the device from the list.

Click [Calibration] to start the calibration process.

Click [ Application] to configure the application types.

6.1 LDSBus Command Interface

LC91110101642200090

58D365A5

LDSBus 2CH Relay

Bx46801

Off

LDSBus 2CH Relay
64

5008

Calibrated Temperature (°C) 6

The LDSBus command interface is used to communicate with the LDSBus module by
selecting the command from the list of supported commands. The command settings are
available only if the device is found on the bus. Refer to Section 5.3 for more information.

6.2 Saving LDSBus Project

Upon creating an LDSBus Project, users may save the project. The steps for saving a LDSU
Project and LDSBus Project is the same. Refer to Section 5.4 for more information.

6.3 Opening a LDSBus Project

The steps for opening a LDSU Project and LDSU Project is the same. Refer to Section 5.5

for more information.
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6.4 LDSBus Right Click Functions

To access the dropdown menu of the device under LDSBus project.

1. Right click the device green square box.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

LDSI Power

On Enable

LDSU IDs LDSU List
Total Online LDSUs: [3 Estimated Power Consumption (mi)

New Online LDSUs:

Filter: ALl

Figure 43 — LDSBus Project - LDSU IDs

2. The dropdown menu will be displayed.

LDSBus Configuration Utility-1DSBus Project

File LDSBus Commands Settings About

LDSBus Power

Enable

LDSU IDs LDSU List

Total Online LDSUs: 3 Estimated Power Consumption (mW) :

New Online LDSUs:

Filter: All

13 97
Identify
Device Info
calibration

Firmuare Update

Export

Figure 44 - LDSBus Right Click Drop Down Menu

31
Product Page

Document Feedback Copyright © BRT Systems Pte Ltd



BRTSYS_AN_001 LDSBus Configuration Utility Guide
Version 1.4

-a BR I Sys Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

Common items shown in the dropdown menu are “Identify,” “Device Info,” “Firmware
Update,” “Export,” “Calibration,” “"Application Setting,” “Profile Setting,” “RFID Setting” and
“Sensor Configuration” are device related.

Identify - To send identify command.
Device Info - To view the LDSU device as shown in Figure 42,

Firmware Update - To update device firmware. Refer to Section 6.5 for more details. On
firmware update.

Export - To save the selected unit’s data to LDSU project file.

Calibration - To perform calibration. Refer to Section 7 for more details on calibration
procedure.

Application Setting - To configure application Type. Refer to Section 8 for more
information related to application type configuration.

Profile Setting - To configure profile setting. Refer to Section 8.3 for more information
on Profile Setting.

RFID Setting - To configure RFID Setting. Refer to Section 8.4 for more information on
Configuring RFID Setting.

Sensor Configuration - To configure Senor Setting. Refer to Section 8.5 for more
information on Sensor Configuration Setting.

LDSBus Configuration Utility-1DSBus Project

File LDSBus Commands Settings About

LDSBus Power

Status: On

LDSU IDs LDSU List

Total Online LDSUs: |3 Estimated Power Consumption (mi)

New Online LDSUs

Filter: [NSY

1 13 1l 97 |
Identify

Device Info
calibration
Firmware Update
Export

Figure 45 — LDSBus Dropdown Menu
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6.5 LDSBus Firmware Update
To update device’s firmware under LDSBus project —
1. Right click and select the device for which the firmware needs to be updated; From the

resulting drop-down menu, click on [Firmware Update] to start the firmware update
process.

Filter: [CUNI

T
B ] Ll oo |

| Identify
Device Info
Calibration

Firmware Update

| Export

Figure 46 — Drop Down Menu - Firmware Update

2. Open File Dialog window will pop up for users to select the unv file; choose the correct
unv file and click [Open] to continue. Alternately, click [Cancel] to cancel firmware
update.

O Browse unv Files *
Look in: | | LS1301 v @ % i m-

ﬁ Mame - Date modified Type

~|LDSBus_Salinity_Sensor 2/8/2023 11:25 am UMY

Quick access

Desktop

|

Libraries

< >

File name: || ¥ | | Open |

Files of type: uny files (".unv) wr Cancel
Open as read-only
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3. A confirmation window will pop up. Click [Yes] to confirm the firmware update operation
or click [No] to cancel the update.

Current Version 2.1

Update to Version 2.3

4, LDSBus Firmware update status window will pop up to show the progress of the firmware
update.

LDSBus Firmware Update Status
ID: 11 UUID: L516818101642260636

Update firmware, this will take a while

94% l

5. Upon successful completion of update, an appropriate message indicating the same will
be displayed. Click [OK] to return back LDSBus Project window.

Firmware update completed
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7 Calibration Procedure

From V1.2.2 of the configuration utility, sensor calibration may be performed in-situ on the LDSBus,
i.e. the sensor adapter and probe need not be removed from the bus and prevents any disruption to
the existing setup in the field. For in-situ calibration, detach the RJ-45 cable from the gateway

LDSBus Port and attach it to the RJ-45 interface of the LDSBus USB Adapter and open an LDSBus
Project in the utility, instead.

7.1 LDSBus pH Sensor Adapter Calibration
To calibrate pH Sensor Adapter, follow these steps —

1. Click [Calibrate] from the LDSU / LDSBus Project interface.

LD5Bus Configuration Utility-LDSU Project

File  LDOSU Comvmands Firmasrs Update

2. An information window prompting
the users for Power Selection is
displayed. LDSU Calibration
requires 24V  Power supply.

Calibrati requires 24V LDSBus Power.
Remove the sensor module and S e e i

Remove and attach pH Sensor adapter to a LDSBus

attach to the HVT-Junction HVT-Junction connected to the LDSBus Port.
connected to the LDSBus Port.
Click [Ok] to continue or [Cancel] | .

to quit the calibration process.

Cancel
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3. Upon clicking [Ok], a confirmation
window prompting the user to
switch from LDSU Port Power to
LDSBus Port Power is displayed.
Click [Ok] to switch. Alternately, SMfChL;;gmrLgsﬂtpg"’f il
click [Cancel] to exit the S0 ToRs Tort fowers
calibration process.

4. Upon clicking [Ok], the project window will be in disabled mode and the countdown
timer starts as shown in the picture indicating that the power switching is in
progress.

< LDSBus Configuration Utility-LDSU Project

File LDSU Commands Fir re Update

First Point Calibration

5. Upon successful power switch, system will prompt the users to start the calibration.
Click [OK]. The interface for the First point calibration for 7pH is displayed. Prepare
Buffer solution (7pH and one more optional). There should be two sets of beakers
for each solution. Beaker 1 is used to clean the probe before a calibration and
Beaker 2 is used for the actual calibration measurement. Temperature can be
edited if required. Upon preparing the solutions, click on the Beaker-2 for
Calibration 7pH checkbox.

36

Product Page
Document Feedback Copyright © BRT Systems Pte Ltd



BRTSYS_AN_001 LDSBus Configuration Utility Guide

-a BRTSYS Version 1.4

Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

pH - First point calibration - 7pH

Temperature

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

Start Calibration

6. Remove the electrode from its storage solution and rinse it with distilled water in

an empty waste beaker. Upon rinsing the probe with distilled water, click on the
Rinse the probe with distilled water check box.

pH - First point calibration - 7pH

Temperature

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

Rinse the probe with distilled water

Cancel

7. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe

with Kimwipes or Shurwipes checkbox. (Avoid rubbing the electrode because it has
a sensitive membrane).

pH - First point calibration - 7pH
Temperature
Prepare solutions in 2 beakers

> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Cancel
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8. Use Beaker 1 (7pH) to rinse the electrode. Use Beaker 2 (7pH) to place the
electrode to start the calibration. Rinse the probe in beaker 1 (7pH), then click the

Rinse the probe in beaker-1 checkbox.

pH - First point calibration - 7pH

Temperature

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

Rinse the probe with distilled water
Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

9. An information window will appear. Click [Ok] to proceed. The calibration window
will be in disabled mode and the countdown timer starts as shown in the picture.

Wait for 60 seconds to stabilize the readings.

pH - First point calibration - 7pH

Temperature

Rinse t|

tep, the probe has to be
Dry the i cir b 3.
: Calibration will tak
Rinse t

Cancel

10. Check the result. If the first point calibration is unsuccessful,

an error message is

displayed. Click [Retry] to start the first point calibration again (Repeat Steps 5 -

10 until the first point calibration is successful).

pH - First point calibration - 7pH

Temperature

ticekEl

Rinse t First point calibration fail.

Dry the Offset deviation not within the range of %
30.0 mv.

Rinse t

ok

Immerse

Probe offset (Range +30.0mV)
®
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11.Upon successful calibration, an appropriate message indicating the same is
displayed. Click [Ok] to continue. The Calibration result will be displayed. Click
[Next] to proceed with the Second point calibration.

pH - First point calibration - 7pH

Temperature

Rinse t|
First point calibration Successful
Dry the
Rinse t|
Immerse

Origin lﬁ'@'en'ﬂ—rmng@ ¥

Second Point Calibration

12.Upon successfully completing the First Point Calibration, the Second Point
Calibration interface is displayed. Prepare Second buffer solution. There should be
two sets of beakers for each solution. Beaker 1 is used to clean the probe before a
calibration and Beaker 2 is used for the actual calibration measurement. Upon
preparing the solutions, click on the Beaker-2 for Calibration 4.00pH checkbox.

pH - Second point calibration - 4pH

Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.@@pH

13.Remove the electrode from its storage solution and rinse it with distilled water in
an empty waste beaker. Upon rinsing the probe with distilled water, click on the
Rinse the probe with distilled water check box.

pH - Second point calibration - 4pH

Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.@@pH

Rinse the probe with distilled water

Cancel
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14. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe
with Kimwipes or Shurwipes checkbox.

pH - Second point calibration - 4pH

Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.0@pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

15. An information window will appear. Click [Ok] to proceed. The calibration window
will be in disabled mode and the countdown timer starts as shown in the picture.
Waiting for 60 seconds to stabilize the readings.

pH - Second point calibration - 4pH

Second buffer solution

Rinse t|

In the next step, the probe has to be
immersed in bea

s Calibration will take seconds.
Rinse t| ‘lIII"

Dry the

Cancel

16.Check the result. Upon successful calibration, an appropriate message indicating
the same is displayed. Click [Ok] to continue.

pH - Second point calibration - 4pH

Second buffer solution

Calibration Successful.
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17.The Calibration result will be displayed. Click [Update] to flash the calibration data
into the device. System will switch power from LDSBus Port to LDSU Port.

pH - Second point calibration - 4pH

Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.00pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes
Rinse the probe in beaker-1

Immerse the probe into beaker-2

Slope (Range 90%-105%)

18. If the calibration fails, then appropriate error message is displayed. Click [Ok].
pH - Second point calibration - 4pH

Second

Second point calibration fail.
Slope deviation not within the range of

Immerse=e

Slope (Range 90%-105%)

19. Click [Retry] to do the second point calibration again. (Repeat Steps 13 - 19 until
the calibration is successful) or click [Cancel] to exit the calibration process. Upon

cancelling the calibration process, system will switch power from LDSBus Port to
LDSU Port.

pH - Second point calibration - 4pH
Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.@@pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1
Immerse the probe into beaker-2

Slope (Range 90%-185%

Cancel

Post Completion or Cancellation of Calibration Process

41
Product Page

Document Feedback Copyright © BRT Systems Pte Ltd



OBRTSys

BRTSYS_AN_001 LDSBus Configuration Utility Guide

Version 1.4

Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

20

21,

22,

.Upon successful completion or
cancellation of calibration
process, system will switch power
from LDSBus Port to LDSU Port.

An information window
prompting the users to detach
the LDSBus pH Sensor Adapter
from the LDSBus HVT-Junction
and attach to the LDSBus USB
Adapter RJ11 Port is displayed.
Click [Ok].

Upon clicking [OK], the project

Turning off LDSBus Port Power

Detach LDSBus Sensor Adapter from the LDSBus HVT-

Junction

and attach to the LDSBus USB Adapter RJ11 port.

window will be in disabled mode and the countdown timer starts as shown in the
picture indicating that the power switching is in progress.

< LDSBus Configuration Utility-LDSU Project

File LDSU Commands

Firmware Update Settings

About

LDSBus pH Sensor
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7.2 LDSBus EC/Salinity Sensor Adapter Calibration

To calibrate EC / Salinity Sensor Adapter, follow these steps -

1. Click [Calibrate] from the LDSU / LDSBus Project interface to start the calibration.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU Port Power
Status: On
LDSU

UUID LS850160101842200058
LDSU ID v

Serial Number Sl 7

LDSU Termination
LDSBus EC Sensor

Product Name
roduc ame Nicknane LDSBus EC Sensor

LDSU Class g

Manufacture Date 202,

Calibrated Current (mA) 40

Calibrated Volt. (mv) 5148

Calibrated Temperature (°C) 2%

Calibrated Date S

Number of I2C Devices i

Software Versi 2.1

I2C Devices

Manufacturer : Bridgetek Pte Ltd.
PartNumber BRT-VDEV

Address : 2}

Capability : @

Report R 180@ ms

Class ID : @x@901
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2. An information window
prompting the wusers for
Power Selection is
displayed. LDSU Calibration
requires 24V Power supply.
Remove the sensor module
and attach to the HVT-
Junction connected to the
LDSBus Port. Click [Ok] to
continue or [Cancel] to quit
the calibration process.

Upon clicking
confirmation window
prompting the user to
switch from LDSU Port
Power to LDSBus Port Power
is displayed. Click [Ok] to
switch. Alternately, click
[Cancel] to exit the
calibration process.

[Ok], a

Upon clicking [OK], the project window
will be in disabled mode and the
countdown timer starts as shown in the
picture indicating that the power
switching is in progress.

First Point Calibration

5. Upon successful power switch, system will
prompt the users to start the calibration.
Click [Ok]. The interface for the First
point calibration for EC Sensor is
displayed. Prepare Buffer solution (EC
Sensor and one more optional). There
should be two sets of beakers for
each solution. Beaker 1 is used to
clean the probe before a calibration
and Beaker 2 is used for the actual
calibration measurement.

Prepare solutions in 2 beakers

Temperature/Probe Type/EC
Solution can be edited if required.
Upon preparing the solutions, click
on the Beaker-2 for Calibration
checkbox.

EC - First point calibration
Temperature
Probe Type

EC Solution

Calibration requires 24V LDSBus Power.

Remove and attach Sensor adapter te a LDSBus HVT-
Junction connected to the LDSBus

Port.

Switch from LDSU Port Power
to LDSBus Port Power?

Start Calibration

degC
K
1.413 ms/cm

@0

> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Cancel
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6. Remove the electrode from its
storage solution and rinse it with
distilled water in an empty waste
beaker. Upon rinsing the probe with
distilled water, click on the Rinse the
probe with distilled water check box.

7. After rinsing, wipe dry with
Kimwipes or Shurwipes and click

on the Dry the probe with
Kimwipes or Shurwipes checkbox.
(Avoid rubbing the electrode
because it has a sensitive
membrane).

8. Use Beaker 1 to rinse the
electrode. Use Beaker 2 to place
the electrode to start the
calibration. Rinse the probe in

beaker 1, then click the Rinse the
probe in beaker-1 checkbox.

EC - First point calibration
Temperature
Probe Type

EC Solutien

ws/cn

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Cancel

EC - First point calibration

Temperature degC

B <
1.413 mS/cm

Probe Type
EC Solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

EC - First point calibration

Temperature degC

K
m/cn

Probe Type

EC Solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water
Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1
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9. An information window will appear
prompting for immersing the probe
in beaker 2. Click [Ok] to proceed.

In the next step, the probe has to be immersed in

EC - First point calibration

10. Upon immersing the probe, click on
the corresponding checkbox. Wait [EESEAEEE
for 60 seconds to stabilize the [
readings. EC Solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water
Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

=
Immerse the probe into beaker-2 . E

Cancel

11.Upon successful calibration, an
appropriate message indicating the
same is displayed. Click [Ok] to
continue. The Calibration result will First point calibration pass.
be displayed.

12. Click [Next] to proceed with the EC - First point calibration
Second point calibration. Temeratin

Probe Type
EC Solution

Prepare selutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

Immerse the probe into beaker-2

First Point Result P
Cancel
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Second Point Calibration EC - Second point calibration
Temperature
13.Upon successfully completing the First RSy
Point Calibration, the Second Point
Calibration interface is displayed.

EC Solution

Prepare solutions in 2 beakers

Prepare Second buffer solution. There § Reskaruilrorprohe cloaing

should be two sets of beakers for each o Bt Gal el E
solution. Beaker 1 is used to clean the

probe before a calibration and Beaker 2
is used for the actual calibration
measurement. Upon preparing the
solutions, click on the Beaker-2 for
Calibration checkbox. e

14.Remove the electrode from its storage [FaEETI N
solution and rinse it with distilled water
in an empty waste beaker. Upon rinsing
the probe with distilled water, click on [ERERIE K
the Rinse the probe with distilled water REIEINEEy 5
check box.

Temperature 5. degC

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water . D

15. After rinsing, W|pe dry with EC - Second point calibration
Kimwipes or Shurwipes and click on RS 25. e
the Dry the probe with Kimwipes or [ESSEs ¢

Shurwipes checkbox. S w5/

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes I E

Cancel
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16.Rinse the probe in beaker solution.
Once done, click on the Rinse the
probe in beaker-1 checkbox.

17.An information window will appear
prompting for immersing the probe
in beaker 2. Click [Ok] to proceed.

18.Upon immersing the probe, click on
the corresponding checkbox. Wait
for 60 seconds to stabilize the
readings.

19.Upon successful calibration, an
appropriate message indicating
the same is displayed. Click [Ok]
to continue. The Calibration result
will be displayed.

EC - Second point calibration

Temperature

‘

Probe Type

EC Solution

ms/cn

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water
Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

In the next step, the probe has to be immersed in
beaker-2.
Calibration will take 60 seconds.

EC - Second point calibration
Temperature

K

12.88 mS/cm

Probe Type
EC Solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water
Dry the probe with Kimwipes or Shurwipes
Rinse the probe in beaker-1

Immerse the probe into beaker-2

Calibration successful.
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20.The second point calibration result
will be displayed. Click [Update]

to flash calibration data into
EEPROM or click [Cancel] to avoid
saving data.

21.Upon successful update, an

appropriate message indicating the
same is displayed.

22.LDSBus Power will be switched off.

23.Connect the sensor back to the
USB adapter after removing it from
the HVT junction, and then click
[Ok]. For power switching, wait 60
seconds.

24.1In the main window, the calibration

EC - Second point calibration
Temperature .0 degC
Probe Type K

EC Solution mS/cm

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1
Immerse the probe into beaker-2

Second Point Result

Update Successful

Turning off LDSBus Port Power

Detach LDSBus Sensor Adapter from the LDSBus HVT-
Junction
and attach to the LDSBus USB Adapter RJ11 port.

date will be updated after the utility scans the device again.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update

Settings  About

LDSU Port Power T
Status: On Enable

LDSU
uuIpD

Serial Number Elpciis

Product Name SRR

LDSU Class

Product Page
Document Fee

Manufacture Date
Calibrated Current (mA)

Calibrated Voltage (mV)
Calibrated Temperature (°C) 25

Calibrated Date 2022-Dec-13

LDSU ID

LDSU Termination

LDSBus EC Sensor

Nickname

Pte Ltd
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7.3 LDSBus DO Sensor Adapter Calibration

To calibrate DO Sensor Adapter, follow these steps =

1. Click [Calibrate] from the LDSU / LDSBus Project interface to start the calibration.

LDSBus Configuration Utility-LDSU Project

File | LDSU Commands Firmware Update Settings About
LDSU Port Power

Enable

LS100101018422680851
LDSU ID

Serial Number V84905E6

LDSU Termination
LDSBus DO Sensor

Product Name
roduc ame Ni ckriame LDSBus DO Sensor

LDSU Class —
Update

Manufacture Date
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2. An information window prompting
the users for Power Selection is
displayed. LDSU Calibration
requires 24V Power supply.

Remove the sensor module and Calibration requires 24V LDSBus Power.
attach to the HVT-Junction Remove and attach Sensor adapter to a LDSBus HVT-
connected to the LDSBus Port Junction connected to the LDSBus Port.
Click [Ok] to continue or " }

[Cancel] to quit the calibration L J Cancel

process.

3. Upon clicking [Ok], a confirmation
window prompting the user to
switch from LDSU Port Power to
LDSBus Port Power is displayed.

Click [Ok] to switch. Alternately, Switch from LDSU Port Power
click [Cancel] to exit the to [D5Bus Fort Powert
calibration process. Upon clicking

[OK], the project window will be - ' .

in disabled mode and the | . . Sancel

countdown timer starts.
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4. Upon successful power switch,
system will prompt the users to
start the calibration. Click [Ok].

5. Calibration interface for DO Sensor
is displayed. Using pure water, wet
the probe and click on the checkbox
accordingly.

6. After shaking off excess water, click
the check box.

7. Make sure the probe is exposed to
the air, then click the check box.

8. Upon successful calibration, an
appropriate message indicating the
same is displayed. Click [Ok] to
continue.

Start Calibration

DO Sensor Calibration

Temperature

Wet the probe in pure water

Cancel

DO Sensor Calibration

Temperature

Wet the probe in pure water

Shake off excess water drops

DO Sensor Calibration

Temperature

Wet the probe in pure water

Shake off excess water drops

Expose the probe to the air
Maintain proper air flow

Cancel

Calibration successful.

‘lll.’ i
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9. The calibration result will be displayed. Click [Update] to flash calibration data into
EEPROM or click [Cancel] to avoid saving data.

DO Sensor Calibration

Temperature

Wet the probe in pure water

Shake off excess water drops

Expose the probe to the air
Maintain proper air flow

Sensor Calibration

|| u e Cancel

10. Upon successful update, an appropriate message indicating the same is displayed.

Update Successful

11.LDSBus Power will be switched off.

Turning off LDSBus Port Power

@,

12.Connect the sensor back to the USB adapter after removing it from the HVT
junction, and then click [Ok]. For power switching, wait 60 seconds.

Detach LDSBus Sensor Adapter from the LDSBus HVT-

Junction
and attach to the LDSBus USB Adapter RJ11 port.
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13.In the main window, the calibration date will be updated after the utility scans the
device again.

LDSBus Configuration Utility-LDSU Project

File LDsU Commands Firmware Update

LDSU

wuID 151601010104221
Serial Number 784406E6

Product Name LDSBus DO Sensor
LDSU Class 0x800C
Manufacture Date 2022-Jun-84
Calibrated Current (mA) 2
Calibrated Voltage (mV)

Calibrated Temperature (°C)

Calibrated Date

Number of I2C Devices

Software Version

I2C Devices

Manufacturer : Bridgetek Pte Ltd.
PartNumber BRT-VDEV

Address : 2x80

Capability : @

Report Rate 1608 ms

Class ID : @ 2

Settings

Enable

About

LDSU ID
LDSU Termination

Nickname

LDSBus DO Sensor
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7.4 LDSBus ORP Sensor Adapter Calibration

To calibrate ORP Sensor Adapter, follow these steps —
1. Make one beaker of pure water and connect an ORP sensor to a USB adapter.

2. To scan the ORP sensor, click [Scan], if the sensor has not been calibrated, an alert
will appear asking whether to calibrate. Click [Yes] to start the calibration process.

Device is Not Calibrated, Start Calibration MNow?

Clicking [No] will display the same calibration data screen as the sensor. Click
[Calibrate] to start the calibration.

LDSBus Configuration Utility-LDSU Project

File LDsU Commands Firmware Update Settings About

LDSU ID

Serial Number
LDSU Termination
Product Name LDSBus ORP Sensor

Nickname LDSBus ORP Sensor
LDSU Class

Manufacture Date 822-May -
Calibrated Current (mA) 2

Calibrated Voltage (mV) 3300

Calibrated Temperature (°C) 49

Calibrated Date 2823-Jan-20

Number of I2C Devices it

Software Version 2.3

T12C Devices

Manufactu ridgeTek Pte Ltd.
PartNumber RT-VDEV

Address : 0x@0

Capabilit

Report Rate 1000 ms

Class ID : 8x@305

3. An information window prompting
the users for Power Selection is
displayed. LDSU Calibration
requires 24V Power supply.
Remove the sensor module and Calibration requires 24V LDSBus Power.
attach  to the  HvT-Junction [yt e
connected to the LDSBus Port. Click

[Ok] to continue or [Cancel] to . P

quit the calibration process.
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4. Upon clicking [Ok], a confirmation
window prompting the user to switch
from LDSU Port Power to LDSBus Port
Power is displayed. Click [Ok] to
switch. Alternately, click [Cancel] to
exit the calibration process. Upon
clicking [Ok], the project window will
be in disabled mode and the
countdown timer starts.

5. Upon successful power switch, system
will prompt the users to start the
calibration. Click [Ok].

6. Calibration interface for ORP Sensor is
displayed. Enter the correct calibration
temperature and buffer solution.
Prepare the ORP buffer solution and
click on the checkbox accordingly.

7. Separate buffer solutions into two
beakers, beaker 1 and beaker 2 and
click on the checkbox accordingly.

Switch from LDSU Port Power
to LDSBus Port Power?

Cancel

Start Calibration

ORP Sensor Calibration
Temperature

Buffer Solution (mV)

Prepare ORP buffer solution and Enter detail above E

Cancel

ORP Sensor Calibration
Temperature

Buffer Solution (mV)

Prepare ORP buffer solution and Enter detail above ]

Seperate solution to two beakers: beaker 1 and 2 m

Cancel
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8. Remove the probe from its [RUEEIEEINEIEGICItYy
storage solution, rinse with
distilled water, and blot dry with
Kimwipes or Shurwipes. Upon [EGEEEEEEECINCY)

dOing SO, click the check box. Prepare ORP buffer solution and Enter detail above

Temperature

Seperate solution to two beakers: beaker 1 and 2

Take probe out of storage solution
Rinse with distilled water
Blot dry with Kimwipes or Shurwipes

Cancel

ORP Sensor Calibration

9. Rinse the probe with solution
from beaker 1 and click on the
check box. Buffer Solution (mV)

Temperature

Prepare ORP buffer solution and Enter detail above

Seperate solution to two beakers: beaker 1 and 2

Take probe out of storage solution
Rinse with distilled water
Blot dry with Kimwipes or Shurwipes

Rinse probe in beaker 1 solution

10. Calibrate the probe by putting it REGCEEETREIEEIETEE
in beaker 2 solution and click on
the check box.

Temperature

Buffer Solution (mV)

Prepare ORP buffer solution and Enter detail above

Seperate solution to two beakers: beaker 1 and 2

Take probe out of storage solution
Rinse with distilled water

Blot dry with Kimwipes or Shurwipes
Rinse probe in beaker 1 solution

Put probe in beaker 2 solution for calibration

Cancel
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11. Upon  successful calibration, an
appropriate message indicating the
same is displayed. Click [Ok] to
continue.

Calibration successful.

ORP Sensor Calibration
12.The calibration result will be displayed.
Click [Update] to flash calibration data

into EEPROM or click [Cancel] to avoid
saving data. Prepare ORP buffer solution and Enter detail above

Temperature

Buffer Solution (mV) 25

Seperate solution to two beakers: beaker 1 and 2

Take probe out of storage solution
Rinse with distilled water
Blot dry with Kimwipes or Shurwipes

Rinse probe in beaker 1 solution

Put probe in beaker 2 solution for calibration

Sensor Calibration Result .

= Cancel

13. Upon successful update, an appropriate
message indicating the same s
displayed.

Update Successf

14. LDSBus Power will be switched off.

Turning off LDSBus Port Power

15. Connect the sensor back to the USB
adapter after removing it from the HVT
junction, and then click [Ok]. For power

switching, wait 60 seconds.
Detach LDSBus Sensor Adapter from the LDSBus HVT-

Junction
and attach to the LDSBus USB Adapter RJ11 port.

58

Product Page
Document Feedback Copyright © BRT Systems Pte Ltd



OBRTSys

BRTSYS_AN_001 LDSBus Configuration Utility Guide

Version 1.4

Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

16.In the main window, the calibration date will be updated after the utility scans the

device again.

LDSBus Configuration Utility-LDSU Project

File LDsU Commands Firmware Update Settings About

LDSU
uuID

Serial Number

Product Name

LDSU Class

Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Temperature (°C)
Calibrated Date

Number of I2C Devices

Software Version

I2C Devices

Enable

L516010161842 21

LDSU ID
784406E6

LDSU Termination
LDSBus DO Sensor
Nickname
8x808C
2622-Jun-84

48

Manufacturer : Bridgetek Pte Ltd.

PartNumber BRT-VDEV
Address : 2x80
Capability : @

Report Rate 1608 ms
Class ID : @ 2

LDSBus DO Sensor
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7.5 LDSBus CO2 Sensor Adapter Calibration

To calibrate CO2 Sensor Adapter, follow these steps -

1. Prepare the reference CO2 meter and connect it to the USB adapter to achieve better
accuracy. Make sure that the reading of the environment CO2 is greater than 400ppm.

2. To scan the CO2 sensor, click [Scan], if the sensor has not been calibrated, an alert
will appear asking whether to calibrate. Click [Yes] to start the calibration process.

Device is Not Calibrated, Start Calibration Now?

Clicking [No] will display the same calibration data screen as the sensor. Click
[Calibrate] to start the calibration.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU Port Power
¥ Enable
LDSU

uuID

LDSU ID i
Serial Number

LDSU Termination S

Nickname LDSBus €02 Sensor

Update

Product Name LDSBus CO2 Sensor
LDSU Class x8011
Manufacture Date 622-Nov-25
Calibrated Current (mA)

Calibrated Voltage {(mV)

Calibrated Temperature (°C) 22

Calibrated Date 2020 MoV
Number of I2C Devices &
Software Version =

I2C Devices

Manufacturer : BRT Systems Pte Ltd. M c ROHM Semiconductor
PartNumb 2 i rth 1730FVC

Address

Capability

Manufac : Sensirion Manufact : Sensirion
Parthum Partumbe

Address 3 Addre

Capability : Capability

Report Rat: Report Rate

Class ID : 0 Class 1D :

Report Rate
Class ID :

<

3. An information window prompting the users for Power Selection is displayed. LDSU
Calibration requires 24V Power supply. Remove the sensor module and attach to the

HVT-Junction connected to the LDSBus Port. Click [Ok] to continue or [Cancel] to
quit the calibration process.

Calibration requires 24V LDSBus Power.

Remove and attach Sensor adapter to a LDSBus HVT-
Junction connected to the LDSBus Port.

‘ Cancel
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4. Upon clicking [Ok], a confirmation window prompting the user to switch from LDSU
Port Power to LDSBus Port Power is displayed. Click [Ok] to switch. Alternately, click
[Cancel] to exit the calibration process. Upon clicking [OK], the project window will
be in disabled mode and the countdown timer starts.

Switch from LDSU Port Power

to LDSBus Port Power?

' Cancel

5. Upon successful power switch, system will prompt the users to start the calibration.
Click [Ok]. Wait for 180 seconds for CO2 reading to stabilize.

Start Calibration

6. The calibration result will be displayed. Enter the CO2 reading from CO2 reference
meter. Click [Update] to save calibration data into EEPROM.

SCD4X C02 Sensor Force Recalibration
Send start periodic measurement command

Wait for 3 minutes

Send stop_periodic measurement command

Reference €02 Meter Reading

7. Upon successful update, an appropriate message indicating the same is displayed.

Update Successful
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8. LDSBus Power will be switched off.

Turning off LDSBus Port Power

9. Connect the sensor back to the USB adapter after removing it frdm the HVT junction,
and then click [Ok]. For power switching, wait 60 seconds.

Detach LDSBus Sensor Adapter from the LDSBus HVT-
Junction
and attach to the LDSBus USB Adapter RJ11 port.

10.In the main window, the calibration date will be updated after the utility scans the
device again.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU ID

Serial Number B
LDSU Termination
Product Name LDSBus €02 Sensor

Nickname
LDSU Class e

Manufacture Date 222 Nov 2
Calibrated Current (mA)

Calibrated Voltage (mV)

Calibrated Temperature (°C)

Calibrated Date

Number of I2C Devices

Software Version

I2C Devi

Manufactur : BRT Systems Pte Ltd. Manufactu ROHM Semiconductor Manufacturer : Sensirion Manufact: : Sensirion
PartNumber BRT-VDEV PartNumbe H1738FVC PartNumber : SCD4@ PartNumb: SCD4e
Address Address ax Address : 2 Address : @

Capability : @ Capability Capability : 1 Capability : 1

Report Rate 1000 ms Report Rate 1080 ms Report Rate 5000 ms Report Rate 5000 ms
Class ID : @x@304 Class ID 401 cl D 04 Class ID 00

62
Product Page

Document Feedback Copyright © BRT Systems Pte Ltd



BRTSYS_AN_001 LDSBus Configuration Utility Guide
Version 1.4

-a BR I Sys Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

8 Application Type Configuration
8.1 Relay Controller Application Type Configuration

To configure application type for Relay Controller —

1. Click [Application Type Configuration].

LDSBus Configuration Utility-LDSU Project
File LDSU  Commands Firmware Update Settings About

LDSU Port Power
5 on % Enable
LDSU

VUID LC01116101642200690
LDSU ID

Serial Number
LDSU Termination
LDSBus 2CH Relay

Product Name
roduc EL b5 ek reme LDSBus 2CH Relay

LDSU Class a3 08T
Manufacture Date ARl
64

Calibrated Voltage (mV) 5eee

Calibrated Temperature (°C) %
Calibrated Date fibcitonl ety
Number of I2C Devices
Applicatior iration

Software Version
I12C Dev:
Manufactu Bridgetek Pte Ltd. Manufacturer : Bridgetek Pte Ltd.
PartNumber : BRT-VDEV PartNumbei 2CH Relay

58

Addr
Capability : 8

: 1008 ms Report Rate : 1808 ms
: 9x0BO8 Class ID : ©x86600

Relay Board Application Type Configuration
LDSU
UUID L€91116161042200090 LDSU ID 13

Product Name |LDSBus 2CH Relay LDSU Termination [Off

Relay Setting

Relay 1: 4 Wire Motor v Relay 2: 4 Wire Motor

Update

3. Select the setting for each relay from the drop-down box. There are different input
windows for the different relay settings. For example, for 4 wire motor, the setting
input will look like the one shown in the picture.

a. The settings shown in the 4-wire Motor Setting, indicate that the motor is
powered via the COM-NO contacts of Relay 1, i.e., when Relay 1’s contacts
are in COM-NC, the power is OFF.

63

Product Page
Document Feedback Copyright © BRT Systems Pte Ltd



BRTSYS_AN_001 LDSBus Configuration Utility Guide
Version 1.4

-a BR I Sys Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

b. Similarly, when Relay 2’s COM-NO contacts are closed, the motor is driven
in the forward (FWD) direction and when COM-NC contacts are closed, the
motor is driven in the reverse (REV) direction. The user shall determine the
forward and reverse directions of the motor.

Relay Board Application Type Configuration

LDSU ID

LDSU Termination

Relay Setting

SEVEE 4 Wire Motor ~ Relay 2: 4 Wire Motor

None
Generic DOUT

4 Wire Motor

Update

4-Wire Motor Setting
Settings
Relay 1: Power

Relay 2: Direction

Power: . NO = ON, NC = OFF ~

Direction: NO = FWD, NC = REV +~

Timer: Not timed
Time onoff (secs): 65535
Grd_Time OnOff (secs):

Grd_Time OffOn (secs):

B Set Application Reference?

Set Data

4. Once all relays are configured, click [Update] to save the settings to the device’s
EEPROM. A confirmation window will be displayed whether to update the
application. Click [Yes] to update; [No] to cancel the update. Upon successful
update, an appropriate message indicating the same will be displayed.

Confirm Application Update? Application Data Update Successful!
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8.2 10 Controller Application Type Configuration
To configure application type for I0 Controller Module -

1. Click [Application Type Configuration].

LDSBus Configuration Utility-LDSU Project

File LDsu Commands Firmware Update Settings About

LDSU Port Power

Enable

LCP6010101042200892

LDSU ID &
DB8BABIBE

Serial Number
LDSU Termination il
LDSBus Isolated I0 Centroller

Ereduct hors N3 cknzme LDSBus Isolated IO Controlle
LDSU Class BaGHAT

Manufacture Date paze tars0 s
Calibrated Current (mA)

Calibrated Voltage (mV) EEEE
Calibrated Temperature (°C) 6@

Calibrated Date Not Applicable

Number of I2C Devices

Software Version

I12C Devices

Manufacturer : Bridgetek Pte Ltd. Manufacturer : Bridgetek Pte Ltd. Manufacturer : Bridgetek Pte Ltd.
BRT-VDEV PartNumber : DIO-CONTROLLER PartNumber : ATO-CONTROLLER
Address : @x58
Capability : Capability : @
Report Rate 280 ms Report Rate : 1800 ms : 1608 ms
Class ID : 8xCO81 Class ID : @x8CO8 Class ID : @x@BFF

2. A window will appear asking for a new configuration if the IO controller board was
configured previously. Click [Yes] to change the setting; [No] to not change the
setting.

Application Already Configured For This Device, Do

You Want To Configure Again?

Alternatively, if the IO controller has not been configured previously, this window
will not appear.

Click [Yes] to configure the IO controller application type. If no configuration is
done on the board, the following window will appear.
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10 Controller Application Type Configuration

LDSU
UUID LCO6010101642200097 LDSU ID 97

Product Name LDSBus Isolated IO Controller LDSU Termination Off

Output
Generic AIN A VINERN Generic AQUT

None Al AR None
Generic DIN POVINERN Generic DOUT

None DOUT2: [l

Number of Bytes Left: 104

Update

In total, there are 8 channels that can be configured. Below is a list of the input
definitions of all channels.

AIN1 - Analog input channel 1
AIN2 - Analog input channel 2
DIN1 - Digital input channel 1
DIN2 - Digital input channel 2
AOUT1 - Analog output channel 1
AOUT2 - Analog output channel 2
DOUT1 - Digital output channel 1
DOUT2 - Digital output channel 2

AIN 1 & AIN 2 Channels

Both AIN1 and AIN2 have the same drop-down options -

10 Controller Application Type Configuration
LDSU
UUID LCP6010101042200897 LDSU ID 97

Product Name |LDSBus Isolated IO Contreoller LDSU Termination Off

Output

Generic AIN PLAOVINEEN 1-10V Dimmer

None
Generic AIN ADUT2: L4

DOUT1: [lsIgls]

DOUT2: [[el3ls]

Number of Bytes Left: 69

Update

o None - Not Configured
o Generic AIN - General Analog input configuration
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DIN 1 & DIN 2 Channels

Both DIN1 and DIN2 have the same drop-down options -

I0 Controller Application Type Configuration
LDSU
UID LCB6@18101842200897 LDSU ID 97

Product Mame LDSBus Isolated I0 Controller LDSU Termination OFff

Output
Bl Generic AIN v LOVIBERN 1 - 10V Dimmer

AOUT2: Lle]yls]

None

Generic DIN DOUT2: QIS

Number of Bytes Left: 69

Update

o None - Not Configured
o Generic DIN - General Digital input configuration

AOUT 1 & AOUT 2 Channels

Both AOUT1 and AOUT2 have the same drop-down options -

10 Controller Application Type Configuration
LDSU
UUTD LCRE@10101842260097 LDSU ID 97

Product Name |LDSBus Isclated IO Controller LDSU Termination OFff

Input Output
INGIERE Generic AIN LOTIBERN 1 -10V Dimmer

None

0-10V Dimmer

Number of Bytes Left: 69

Update

None - Not Configured

Generic AOUT - General Analog Output configuration
0-10V Dimmer - To configure 0-10V Dimmer

1-10V Dimmer - To configure 1-10V Dimmer

O O O O
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0-10V Dimmer / 1-10V Dimmer

> The LDSBus Isolated IO Controller supports 0-10V and 1-10V application
types. Upon selecting 0-10V / 1-10V Dimmer, the respective
configuration interface is displayed.

Dimmer @ To 10V Sensor Dimmer 1 to 1@V Sensor
Settings Settings

21 ADC Data (8~1823): 22 ADC Data (0~1023):
Each entry represents Each entry represents
5% brightness 4.5% brightness

Separate each data Separate each data
point with new line point with new line

21 Data

Set Data Set Data

The user has to input a brightness curve. A brightness curve attempts to
compensate for the non-linearities of the lighting element (e.g.,
incandescent bulb, CCFL, LED). There are 2 steps to perform. In the first
step, the user has to obtain the brightness curve from the manufacturer.
This brightness curve shall provide information for Luminance (Brightness)
in units of Lux versus the 0-10V or 1-10V input. In the second step, the user
shall then divide the Brightness range (0 Lux to Maximum Lux) into 21 or
22 equal points. For each point the corresponding voltage may be picked
from the brightness curve. Then this voltage (Analog_Voltage) shall be
converted into an ADC value through the following formulae:

a. 0-10V:
ADC value = Analog_Voltage/10 * 1023

b. 1-10V:
ADC value = Analog_Voltage/9 * 1023

For example, if the brightness curve of a 0-10V light has example value
pairs as follows:

0 Lux, OV
10 Lux, 1V
50 Lux, 2V
100 Lux, 3V
200 Lux, 4V
400 Lux, 5V
400 Lux, 6V
400 Lux, 7V
400 Lux, 8V
400 Lux, 9V
400 Lux, 10V

ragirmia= o (= B B =« B o I o g Y
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Then the brightness range is between 0-400Lux and the 21 Lux points will
each have a step of 20 Lux (400Lux/20). For each Lux point, the analog
input voltage can be interpolated from the above table. For e.g. At 50%
brightness, the Lux value is 200 and this corresponds to 4V. The
corresponding ADC value is:

ADC = 4/10 * 1023 = 409 (rounded to the nearest integer)

For example, if the brightness curve of a 1-10V light has example value
pairs as follows:

0 Lux, 1V

10 Lux, 2V
50 Lux, 3V
100 Lux, 4V
200 Lux, 5V
400 Lux, 6V
400 Lux, 7V
400 Lux, 8V
400 Lux, 9V
400 Lux, 10V

raiaies (e B I O W @ B ©

Then the brightness range is between 0-400Lux and the 22 Lux points will
each have a step of 19 Lux (400Lux/21). For each Lux point, the analog
input voltage can be interpolated from the above table. For e.g. At 75%
brightness, the Lux value is 300 (linear interpolation) and this corresponds
to 5.5V. The corresponding ADC value is:

ADC = 5.5/9 * 1023 = 625 (rounded to the nearest integer)
DOUT 1 & DOUT 2 Channels

Both DOUT1 and DOUT2 have the same drop-down options -

I0 Controller Application Type Configuration

LDsSU
uuID LCoeR10101642200897 LDSU ID 97

Product Name |LDSBus Isolated IO Controller LDSU Termination Off

Output

v AOlI RN 1 - 10V Dimmer ¥

Bl Generic AIN

None

Number of Bytes Left: 69

Update

o None - Not Configured
o Generic DOUT - General Digital Output configuration
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In the event that the configuration space is limited, an appropriate message will be
displayed to indicate that there is not enough EEPROM space to configure the
application type.

8.3 Trailing Edge Dimmer Profile Setting
To configure profile setting for LDSBus Trailing Edge Dimmer -

1. Click [Profile Settings].

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU 1D
Serial Number pHiCeonE

LDSU Termination
ProdicE Name LDSBus Trailing Edge Dimmer

Nickname LDSBus Trailing Edge Dimmer
LDSU Class 0x4000

Manufacture Date 2022-0ct-17
Calibrated Current (mA)
Calibrated Voltage (i
Calibrated Temperature (°C)
Calibrated Date Not Applicable

. Profile Settings
Number of I2C Devices E

Software Version

I2C Devices

Manufacturer : Bridgetek Pte Ltd. Manufacturer : Bridgetek Pte Ltd.
PartNumber BRT-VDEV PartNumber Light Dimmer
Address : 0x00 Address : ©Bx58

Capability : @ Capability

Report Rate 1000 ms Report Rate 10080 ms

Class ID : 2] Class ID : 83

2. The profile selection panel will appear and the current setting will be displayed.

LDSBus Configuration Utility-LDSU Project

File LDSU  Commands Firmeare Update Settings

LC8301816851022

LDSU ID
erial Number D81CCosr

LDSU Termination e
Product Name

Nickname
LDSU Cl1. 1

Manufacture Date

Select Profile
Calibrated Current (mA)

IKEA_LED1632G5
S e 5600
Calibrated Voltage (mV) Brand: TKEA

Calibrated Temperature (°C) 62 Model: LED1632G5

Calibrated Date Not Applicable
Number of I2C Devices 2

Software Version il

I12C Devices

Manufactu Bridgetek Pte Ltd. Manufactur ridgetek Pte Ltd.
PartNumbe BRT-VDEV PartNumber Light Dimmer

Addre [z} Addres.

Capability : @ Capability :

Report Rate : 1000 ms Report Rate : 1808 ms

Class ID : 400 Class ID : 6/
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3. Click on the Select Profile drop down box and select a different default profile.
Depending upon the selected profile, the details are displayed. For example, if the
selected profile is IKEA_LED1632G5, then the brand name and model is displayed.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

Firmware Update

LDSU Port Pom
tu: On Enabl

LDSU
uu

Serial Number

Product Name

LDSU Cla

Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Temperature (°C)
Calibrated Date

Number of I2C Devices

Software Version

12€ Devices
Manufacturer
PartNumb
Address
Capability : ©
Report Rate
Class ID :

Bridgetek Pte
BRT-VDEV

1000 ms
@xa480

LCA3816810510:
D81C F

LDSBus Trailing E Dimmer

Not Applicable
2

1.1

Manufacturer
PartNumber : L
Address : 8x58
Capability : @
Report Rate
Class 1D :

t Dimmer

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

Serial Number
Product Name
LDSU Class
Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Temperature (°C)
Calibrated Date
Number of I2C Devices

Software Version

I2C Devices

Manufacturer : Bridgetek Pte
PartNumber BRT-VDEV
Address : 0x00

Capabili )

Report Rate
Class ID : @

1068 ms
x8400

Firmuare Update

910105102 2
D81CCB6F
LDSBus Trailing Edge Dimmer
o 00
2022-0ct-17
125
5000
65

Not Applicable

Manufactu
PartNumber :

Bridgetek Pte
Light Dimmer

¥
Report Rate
Class ID :

1808 ms
x8603

LDSU ID

LDSU Termination

Nickname

Select Profile
IKEA LED1632G5

LDSBus Trailing Edge Dimmer

Aeon_D7@838NTF

Aeon_HALO-V2
Aeon_ISA_V3_Sand_white

Generic

IKEA LED16326G5

Oranlife X@@17EMCVWW_LED_248V_56Hz
OSRAM_9633-SWH-600K

Philips_4.9W

Philips_5923431U0
RS_PRO_Halogen_Lamps_240V_50Hz_400W
Zhuhai_ShengChang KVF-12866-TDWS

Bridgetek Pte Ltd.

LDSU ID

LDSU Termination

Nickname

Select Profile
TKE, ED1632G5

Brand: IKEA
Model: LED1632G5

Update Setting .

Upon selecting the profile, click [Update Setting] to update the profile to the
EEPROM. Once the profile has been successfully updated, the utility will return to

the main window.
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8.4 RFID Configuration Settings
To configure RFID setting for LDSBus RFID Reader -

1. Click [RFID Settings].

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Enable

UUID LCO5010187142200006

LDSU 1D

Serial Number ©147CEB6

LDSU Termination
Product Name LDSBus RFID Reader

Nickname
LDSU Class

Manufacture Date

Calibrated Current (mA)

Calibrated Voltage (mV)

Calibrated Temperature (°C)

Calibrated Date I dgpliosilane
Number of I2C Devices L

Software Version 2l

I2C Devices

Manufactur : BRT Systems Pte Ltd.

2. The RFID setting window will pop up with the current settings as shown in the

picture below.

RFID Setting
LDsU

uuID LCe581818714228808086

Product Name LDSBus RFID Reader

LDSU ID

LDSU Termination off

RFID Mode Setting
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3. Change the settings by clicking on the checkbox to enable or disable buzzer, low
freq. mode and high freq. mode; Click [Save] to save the new settings to the
device (if any).

RFID Setting
LDSU
UuIbD LCR5818107142208080

Product Mame LDSBus RFID Reader
LDsU ID

LDSU Termination

RFID Mode Setting

r

8.5 Soil Sensor Configuration Settings
To configure Soil sensor setting for LDSBus soil sensors -
1. Click [Sensor Configuration].
DSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU Port Powe
Enable

LDSU ID £

Serial Number

Product Name

LDSU Class

Manufacture Date

Calibrated Current (mA)

Calibrated Voltage (mV)

Calibrated Temperature (°C) |2

Calibrated Date Hattpplicab e
1

Number of I2C Devices

Software Version 2.3

12C Devices
Manufactur : BRT Systems Pte Ltd.
Capability

Report Rat:
Class ID :

LDSU Termination -

Nickname LDSBus_4inl_SoilSensor

Update

‘Sensor Configuration
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2. The soil sensor setting window will pop up.

Soil Sensor Setting
Current Setting

UuID LSe781e137a72308817

Product Name LDSBus 4inl SoilSensor

LDSU ID 17

LDSU Termination oft ‘

LDSU Class Bx801A

Change Setting

3. Click on the Sensor Type drop down box and select a different type of soil sensor
configuration.

Seil Sensor Setting
Current Setting

UuID LSe7el1el137e72300017
Product Name LDSBus 4inl ScoilSensor
LDSU ID 17

LDSU Termination |Off

LDSU Class Bx881A

JXCT 4inl Soil Sensor
JXCT 7inl Seil Sensor
Honde 2inl Soil Sensor
Honde 7inl Soil Sensor
Honde 8inl So0il Sensor
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4. Upon selecting the Soil Sensor configuration, click [Save] to update the new
setting to the sensor.

Soil Sensor Setting

Current Setting

uuID LSe7elel37e72386a17
Product MName LDSBus #4inl SoilSensor
LDSU 1D 17

LDSU Termination |[OFf

LDSU Class Bx881A

Change Setting

Sensor Type: JXCT 7inl Soil Sensor %

5. Confirmation window will pop up for user input, click [Yes] update the
configuration. Alternatively, click [No] to cancel the update.

Confirm to update selected soil sensor

conftiguration?
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6. Open file dialog window will pop up for users to select the unv file; choose the
correct unv file and click [Open] to start update; click [Cancel] to return back to
Soil Sensor setting window.

_a Browse unv Files bt
Lok in: | | | LSO701 v] @ # £ @
a Mame Date modified Type
X ﬂ:|LDSEus_din'I_SoilSensor 4/7/2023 11:51 am UMY
Quickaccess ™)) nogyic 7in1_SoilSensor 4/7/2023 11:52 am UMY
! M_‘] LOSBus_Honde_2in1_SoilSensor 6/7/2023 8:58 am UMWV
M_"']LDSBus_Honde_?inLSoiISensnr B/7/2023 8:39 am UMV
Desktop ~J|LDSBus_Honde_8in1_ScilSensor £/7/2023 8:59 am UMY
™
Libraries
This PC
$ < >
L@ File name: | e | Open |
Metwork | |
Files of type: urv files (".unv) w Cancel
Open as read-only

7. A progress indicating that the update has started is displayed.

Soil Sensor Setting
Current Setting

uuID

Product Name
LDSU ID 17
LDSU Termination Off
LDSU Class Bx881A

Change Setting

Sensor Type:

L5878181370725380017

LDSBus_7inl SoilSensor

IXCT 7inl Seil Sensor w
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8. Upon successful completion of the update, an appropriate message indicating the
same will be displayed. Click [Ok] to return back to soil sensor setting window.

Configuration Update Done
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9 Contact Information

Refer to https://brtsys.com/contact-us/ for contact information.

System and equipment manufacturers and designers are responsible to ensure that their systems, and any BRT Systems Pte Ltd
(BRTSys) devices incorporated in their systems, meet all applicable safety, regulatory and system-level performance
requirements. All application-related information in this document (including application descriptions, suggested BRTSys devices
and other materials) is provided for reference only. While BRTSys has taken care to assure it is accurate, this information is
subject to customer confirmation, and BRT Systems disclaims all liability for system designs and for any applications assistance
provided by BRTSys. Use of BRTSys devices in life support and/or safety applications is entirely at the user’s risk, and the user
agrees to defend, indemnify, and hold harmless BRTSys from any and all damages, claims, suits, or expense resulting from such
use. This document is subject to change without notice. No freedom to use patents or other intellectual property rights is implied
by the publication of this document. Neither the whole nor any part of the information contained in, or the product described in
this document, may be adapted, or reproduced in any material or electronic form without the prior written consent of the
copyright holder. BRT Systems Pte Ltd, 1 Tai Seng Avenue, Tower A, #03-01, Singapore 536464. Singapore Registered Company
Number: 202220043R.
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Appendix A = Command List
Commands with payload / response

READN
This command is used to read multiple consecutive bytes from an I2C device.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands.

Command

READN

12C Address (Hexadecimal)
(12

Register Address (Hexadecimal)
f

Count (Decimal)

LDS Message Logger - 18:4. 6419447

[1485 -72-80-FF-FF-76-B2

WRITEN
This command is used to write multiple consecutive register locations in an I2C device.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands

Command

WRITEN e,

12C Address (Hexadecimal)

Register Address (Hexadecimal)
Data (Hexadecimal, Bytes seperated with Space or ',')

@1 82 @3 04 @5

LDS Message L r - 18:53:54.8326812

[1e7845]<< 83-01-04-93
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READ
This command is used to read an I2C device register.

LDSBus Configuration Utility-1LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands Response
Device I
Command Payload

READ v
12€ Address (Hexadecimal)
00

Register Adress (Hexadecimal)
7F

LDS Message Logger - 10:35:45.08326274
3
1<

ECHO

The addressed device, if present, shall echo the bytes from the host controller. This
command is a special command to check the communication.

LDSBus Configuration Utility-LDSU Project

File LDsU Commands Firmware Update Settings About

Target LDSU

LDSU ID 3 (exe3)

Commands

Command

ECHO 2 Payload

Checksum

Data (String - Max 32 Chars)

9123456789

Send

r - 15:55:50.5680174
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Commands without payload /response

RESET
This command will reset the LDSU module.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID 15 (@xeF)

Commands Response

<Command without response>

Command

RESET >

- 18:41:33.1733914

IDENTIFY
This command will trigger the LED in the LDSU Device.

LDSBus Configuration Utility-LDSU Project

File LDSU | Commands Firmuare Update Settings About
Settings and more (4

~Target LDSU

LDSU ID 126 (@x7E)

r Commands r Response

<Command without response>

Command

IDENTIFY

Send
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I2CREGOFF
This command will turn off the 16bit register access

LDSBus Configuration Utility-LDSU Project

File LDSU Commands. Firmware Update Settings About

rTarget LDSU

LDSU ID

Commands 1 r Response

<Command without response>

Command

SETI2CREGOFF >

[ Send

FLDS Message Logger - 11:05:21.4526389

Commands with payload / without response

I2CREGON
This command sets the 12C register addressing to 16-bit mode.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

-target ISY————M9 — M9 M —

LDSU ID

r Commands

Command

SETI2CREGON v

Register MSB (Hex)

E4

11:05:21.452638 —mF 7 —¥—m—mF 00— 00—
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SETI2CSPEED
This command is used to set the I12C Speed (100 KHz or 400 KHz).

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands Response

<Command without respon
Command

SETI2CSPEED e

12C Speed

400KHZ v

er - 15:55:50.5680174

WRITE
This command is used to write a single register location in an I2C device.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmeare Update Settings

LDSU ID 3 (ex@3)

Commands Response

<Command without response>
Command

WRITE

I2C Address (Hexadecimal)
ea

Register Adress (Hexadeciaml)

£

Data (Hexadecimal)
1

LDS Message Logger - 16:48:20.8467172
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Commands without payload / with response

INFO
This command will get the information about the LDSU Module.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands

Command
INFO X

=

- 14:54:22.2822548

86-A1-C6-¢ 2-DC-08-ED-

STATUS
This command will get the last sent command status.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands Response
Device ID

Payload
Command

STATUS bes

- 15:55:58.5680174
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GETUUID
This command will get the device's unique UID.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands

Command

Payload : 5 ©-31-32-37-32-31-4A-00

GETUUID - Checksum :

d
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Appendix B - References

Document References

BRTSYS API 001 LDSBus Python SDK Guide

BRTSYS AN 003 LDSBus Python SDK on IDM2040 User Guide

Acronyms and Abbreviations

Terms Description
LDSU LDSBus Units

LDSBus Long Distance Sensor Bus
usB Universal Serial Bus
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